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ABSTRACT

Autophagosomes and lysosomes work in tandem to conduct autophagy, an intracellular
degradation system which is crucial for cellular homeostasis. Altered autophagy contributes to the
pathophysiology of various diseases, including cancers and metabolic diseases. Although many
studies have investigated autophagy to elucidate disease pathogenesis, specific identification of
the various components of the cellular degradation machinery remains difficult. The goal of this
paper is to describe an approach to reproducibly identify and distinguish subcellular structures
involved in autophagy. We provide methods that avoid common pitfalls, including a detailed
explanation for how to distinguish lysosomes and lipid droplets and discuss the differences
between autophagosomes and inclusion bodies. These methods are based on using transmission
electron microscopy (TEM), capable of generating nanometer-scale micrographs of cellular
degradation components in a fixed sample. In addition to TEM, we discuss other imaging
techniques, such as immunofluorescence and immunogold labeling, which can be utilized for the
reliable and accurate classification of cellular organelles. Our results show how these methods may
be employed to accurately quantify the cellular degradation machinery under various conditions,
such as treatment with the endoplasmic reticulum stressor thapsigargin or the ablation of dynamin-

related protein 1.

INTRODUCTION
Autophagy is the mechanism by which intracellular components or damaged organelles are
removed and degraded to maintain cellular homeostasis [1]. Autophagy is closely linked to

apoptosis, and impaired autophagy can be harmful. Although still poorly understood, autophagy
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regulation 1is critical for cellular homeostasis and has been broadly implicated in disease
pathogenesis [2]. Autophagic balance is important, as both overactive and underactive autophagy
can have negative consequences, such as the malignant transformation and cellular proliferation
in cancer or the accumulation of ineffective cells in neurodegenerative diseases [2,3]. The
autophagic processes can differ depending on the activation pathway, and autophagy can be either
nonselective or selective for specific organelles or proteins in the cell [1,2]. The growing interest
in neurodegenerative and other diseases in which autophagy is implicated has highlighted the
consequential roles played by autophagy in key biological processes [1,4].

Autophagy is a complex and regulated process involving a variety of structures that
contribute to the cellular recycling machinery central of which are autophagosomes and lysosomes.
Typically, autophagy is divided into five main stages: initiation, elongation, autophagosome
formation, fusion, and degradation [1-3]. During the initiation stage, triggered for example by
amino acid starvation, sack-like structures that are precursors of autophagosomes, called
phagophores, assemble at sites at the mitochondria-associated endoplasmic reticulum (ER)
membrane (MAM) [5]. Proximal to the ER, the phagophore can be observed as an empty, unclosed
membrane that elongates and recruits excess materials and cargo for recycling. As materials are
delivered to the phagophore, the membrane closes to seal the organelle, transforming the
phagophore into an autophagosome, a carrier for cytoplasmic components, cargo proteins or
organelles designated for degradation. The autophagosome then fuses with the lysosome, which
contains various hydrolases and permeases, and this results in the formation of a autolysosome.
Upon fusion, the autophagosome releases its contents into the autolysosome, allowing lysosomal
enzymes to initiate the degradation process. Lysosomal hydrolases degrade the materials collected

by autophagosomes, and the resulting macromolecules are released through permeases.
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Autolysosomes are impermeant structures that are dissolved upon the completion of this process.
The components of the autolysosomes can be used to reform lysosomes or become components of
new phagophore membranes, whereas the macromolecules released into the cytosol can then be
recycled for use in other biological functions [1-3,6].

Transmission electron microscopy (TEM) has advanced the field of autophagy research by
enabling the study of subcellular characteristics at high resolution [4]. Specifically, TEM works
by transmitting electrons through ultrathin sections of fixed and embedded samples, generating
nanometer scale micrographs that allow for careful study of all the processes formed throughout
autophagy [7-9]. For example, TEM has facilitated the identification of unique autophagic
structures, revealing that autophagosomes are formed at ER contact sites and has delineated the
five-stage maturation process described above [7,9]. Our method utilizes ImagelJ software for the
analysis of TEM micrographs of autophagic components [10]. ImageJ is a free, open-source
platform that enables the quantification and statistical analysis of images [8]. This study proposes
the application of a method that was adapted and optimized based on an established method for
using TEM to analyze mitochondria and ER, recently described by Lam et al. [8].

The success of the protocol presented here is depends on proper identification of the
cellular degradation components. Lysosomes can present with diverse morphologies, which can
complicate their specific identification. The morphology of lysosomes is usually depicted as a
spherical shape, ranging from 0.05 to 0.2 micrometers in diameter (Figure 1A—C; Table 1) [11].
Lysosomes typically aggregate in the center of many types of cells; however, differing intracellular
conditions, such as raised pH, have been demonstrated to cause lysosomes to migrate toward the
cell membrane [12]. Lysosomes can be classified as primary, secondary, or tertiary, depending on

their digestive activities and the process through which they are formed. Further complicating
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lysosome identification is the frequent tendency of lysosomes to feature multiple membranes [13],
resulting in an appearance similar to that observed for multilamellar bodies (MLBs; Figure 1L-M;
Table 1), which are liposomes that contain lipids within a central compartment surrounded by
many membrane bilayers [14]. Lysosomal membranes feature inner folds that are highly
organized, and the enzymes contained within lysosomes have a distinct, darker, and more
consistent appearance versus the lipids typically found in MLBs (Figure 1A—C, L-M; Table 1).
The lipids found in MLBs can also appear as dots that speckle the MLB interior, which can be
used to differentiate MLBs from lysosomes, although these dots can also be mistaken for cargo in
secondary lysosomes (Figure 1A-C; Table 1). Even with these considerations, the accurate and
reproducible identification of lysosomes based solely on TEM imaging may be inconsistent,
necessitating the application of additional imaging techniques, such as fluorescent staining. Not
only is there a need to positively identify lysosomes, but it is critical that autophagosomes be
identified, characterized, and distinguished from lysosomes as well as other structures.

The appearance of autophagosome can also vary depending on their cargoes, which can
make their identification challenging (Figure 1K—L; Table 1). Ideally, an autophagosome can be
identified by the presence of a clear double-limiting membrane, separated by a short distance, that
appears darker than the rest of the TEM image (Figure 1K; Table 1). However, autophagosomes
may also appear with only a single membrane or with several separate membranes (Figure 1K-L;
Table 1) [15]. These diverse membrane presentations can lead to the misidentification of
malformed mitochondria or ring-shaped ER that present with appearances similar to those of
autophagosomes (Figure 1D-E; Table 1). During identification, the inclusion or exclusion of
certain types of autophagosomes can be performed. If the structures appear empty or lacking in

material, these structures are likely not involved in degradation, and they may be excluded;
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however, care must be taken not to mistake empty autophagosomes for lipid droplets (LDs; Figure
1F-J; Table 1). Similarly, if the body is a phagophore that has not yet closed to form an
autophagosome, this structure is not yet used for recycling and can be inadvertently identified as
an autophagosome [4,15]. Some autophagosomes can be observed in the process of fusing with a
lysosome but cannot yet be considered an autolysosome, and some studies have classified these
structures as autophagolysosomes or autophagosome—lysosome fusions. These structures can be
included in autolysosome or autophagosome quantifications if their inclusion is consistent [1,2].
These intermediate structures can be identified by their much larger appearance, and the contents
inside the lysosome and the autophagosome often appear to be interacting.

When autophagosomes contain smaller volumes of cargo materials (Figure 1D-E; Table
1), they can mimic large, irregularly shaped lysosomes with a double-limiting membrane (Figure
1B; Table 1) [1,11]. Furthermore, lipids are not reliably preserved during sample preparation,
resulting in variations in the appearance of limiting membranes depending on the methods used
[15]. Autophagosomes can also resemble multi-inclusion bodies and multivesicular bodies
(MVBs), which are also known as pre-vacuolar compartments that serve as an intermediary
structure between vacuoles and the frans-Golgi network (Figure 1L-N; Table 1) [16]. Although
these structures are related to autophagy, they are different from autophagosomes and should not
be included in quantifications of autophagosomes [17]. Typically MVBs and MLBs only display
a single membrane (Figure 1L; Table 1); therefore, the presence of a second membrane, in addition
to the identification of inner recycled ribosomes, more circular shapes representing cargo, or more
internal lipids, are all characteristic of autophagosomes (Figure 1D; Table 1) [14,15]. Additionally,
MVBs are generally smaller than autophagosomes and lysosomes, whereas MLBs are larger,

sometimes reaching a size ten times that of a typical lysosome [11,14]. Furthermore,
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autolysosomes (Figure 1C-E; Table 1) may also be mistaken for LDs (Figure 1F-J; Table 1) or
lysosomes (Figure 1A—C; Table 1). Careful consideration of these features should occur to ensure
proper identification of these respective organelles.

Ultrastructural characteristics of other organelles can be used to distinguish them from
autophagic components. For example, the presence of ribosomes, which typically appear as small
black dots around the edge of an unidentified structure, or the observation of a thinner width that
wraps around other organelles, such as mitochondria, are strong ER structural indicators.
Similarly, evidence of mitochondrial cristae or the folds of the mitochondrial inner membrane can
be used to identify mitochondrial structures. However, the exact identification of specific
organelles can be challenging, despite awareness of the typical characteristics of other organelles.
For example, partially degraded ribosomes can aggregate in autophagosomes, thus appearing as
either speckled ribosomes or dark clumps, which increases the likelithood of mistaking an
autophagosome for rough ER [15].

Although the basic processes involved in autophagosome formation are understood, many
of the nuances of the degradation machinery and the specific pathways involved, require further
elucidation. Many downstream effects of autophagy are important. For example, LDs store lipids
that can be mobilized to provide a source of energy retrieval when necessary. Like all organelles,
LDs can be targeted by autophagy for recycling; however, interestingly, the macromolecules
released at the end of autophagy can be stored in newly formed LDs, even under starvation
conditions, to avoid lipotoxicity [18]. Therefore, one downstream consequence of autophagy,
which could evidence ongoing autophagy, is an increase in the presence of LDs within a cell. LDs
protect against ER stress and may serve as a protective barrier against mitochondrial autophagy,

known as mitophagy, by forming close mitochondria-to-lipid contacts [19]. Autophagy impacts
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nearly every cellular organelle due to its role in organelle degradation; for example, ER stress can
trigger the onset of autophagy to recycle the damaged ER membranes and contribute to the
generation of a healthy ER [20]. Similarly, impaired mitochondrial fission or other forms of
mitochondrial dysfunction due for example to impaired function of critical regulatory proteins,
such as mitofusin 1 (MFN1), can trigger mitophagy to clear ineffective mitochondria [21,22].
Because all organelles interact with the cellular degradation machinery, understanding the
dynamics between the primary recycling organelles—lysosomes, autophagosomes, and
autolysosomes—and other organelles will be important to fully appreciate the contributions and
drivers of the autophagic process. Careful and accurate identification of components of the
autophagic machinery will be important for advancing knowledge of the effectiveness of
therapeutics, whose mechanisms of action may involve autophagy. Furthermore, this may result
in further elucidation of pathways that induce autophagy and may clarify how autophagy
contributes to disease prevention and progression [23]. Accurate characterization and
quantification of autophagic machinery components require the proper identification of these
degradation organelles and other subcellular structures involved in the autophagic process.
Although many studies have identified components of the autophagosome and lysosome
machinery, further elaboration of detailed methods for identifying and quantifying these organelles
using rigorous techniques remains critical for establishing standardized protocols for comparison
of data between groups [7,15,24-26]. Previous studies have not consistently evaluated other
important degradation machinery components, such as LDs and autolysosomes, and have not
considered some of the nuances associated with these organelles. Many of these structures are
similar, but they can differ from cell to cell and are easily misidentified. A basic understanding of

the various potential and common appearances of lysosomes and autophagosomes is critical for
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the performance of TEM analysis. Here, we describe the characteristics that should be assessed to
properly identify autophagic organelles and provide recommendations for effective classification
(Supplementary Figure 1).

Our ultimate aim was to identify and quantify difficult-to-measure autophagic machinery
in clear terms and present a novel approach for the measurement all cellular degradation machinery
using a free, open-source software program. These techniques can be applied to reproducibly

quantify and characterize changes that occur in the organelles associated with autophagy.

MATERIALS & METHODS

Mouse Care & Maintenance

Care of mice was performed based on prior protocols [27] and in accordance with protocols
approved by the University of lowa Animal Care and Use Committee (IACUC). We utilized
male C57B1/6J mice. Animals were housed at 22 °C with a 12-h light, 12-h dark cycle, and free
access to water and standard chow. Mice with tamoxifen-inducible knockout of DRP1 in skeletal
muscle were generated by crossing mice that harbored a homozygous floxed allele of DRP1 with
mice harboring a tamoxifen-inducible Cre recombinase under the control of the myogenin
promoter (Jackson Lab) in skeletal muscle as previously described [28,29]. Myotubes were

isolated from these mice, using protocols described below.

Fly Strains and Genetics:
A mitochondrial assembly regulatory factor (Marf) knockdown fly was generated according to

previous protocols [30]. Genetic crosses were performed on yeast corn medium at 22 °C. W1118
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flies were used as genetic background controls. Mef2- Gal4 (I1I) was used to drive muscle-
specific Marf RNAi1 (BS# 55189) to achieve gene knockdown. Mef2-Gal4 (BS# 27390) stocks
were requested or obtained from the Vienna Drosophila Stock Center (VDRC) and Bloomington
Drosophila Stock Center. All chromosomes and gene symbols are as mentioned in Flybase

(http://flybase.org).

Isolation of Satellite Cells & Differentiation

When adopting this protocol, one individual who is blinded to the mouse genotype or treatment
should conduct the experiment, including the isolation, differentiation, and fixation of the murine
and human cells. This individual should not be involved in performing later analyses to mitigate
introducing bias. Satellite cell isolation and differentiation for thapsigargin treatment and DRP-1
ablation were performed as described previously, with minor modifications [8,27,31]. Once
C57B1/J1 mice reached 8—10 weeks of age, mice were placed under anesthesia using isoflurane,
and the skeletal muscles of the gastrocnemius and quadriceps were excised and washed twice with
1x phosphate-buffered saline (PBS) supplemented with 1% penicillin-streptomycin and fungizone
(300 uL/100 mL). Dulbecco’s modified Eagle’s medium (DMEM)-F12 media with collagenase 11
(2 mg/mL), 1% penicillin-streptomycin, and fungizone (300 pL/100 mL) was added to the muscles
and shaken for 90 min at 37 °C. This media was removed, the cells were washed with PBS x4
times, and media replaced with DMEM-F12 media with collagenase II (0.5 mg/mL), 1%
penicillin-streptomycin, and fungizone (300 nL/100 mL), before being shaken for 30 min at 37
°C. The tissue was then ground until all cells were dislodged from the tissue matrix and were
passed through a fine, 70-um cell strainer. The isolated cells were centrifuged, resuspended, and

plated on BD Matrigel-coated dishes. The cells obtained were differentiated into myotubes through
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the addition of DMEM-F12, 20% fetal bovine serum (FBS), 40 ng/mL basic fibroblast growth
factor (R&D Systems, 233-FB/CF), 1x non-essential amino acids, 0.14 mM B-mercaptoethanol,
Ix penicillin/streptomycin, and fungizone (300 pL/100mL). Myotubes were maintained in
medium containing 10 ng/mL growth factor until 85% confluency was reached, at which point

they were differentiated in DMEM-F12, 2% FBS, 1x insulin—transferrin—selenium.

Preparation of cells for TEM

Cells were fixed with 2.5% glutaraldehyde in sodium cacodylate buffer for 1 h in a cell
incubator. They were then embedded in 2% agarose, postfixed in buffered 1% osmium tetroxide,
stained in 2% uranyl acetate, dehydrated with an ethanol gradient series, and embedded in
EMbed-812 resin. Thin sections were cut on an ultramicrotome and stained with 2% uranyl
acetate and lead citrate. Images were acquired by TEM on either a JEOL JEM-1230, operating at

120 kV, or a JEOL 1400, operating at 80kV.

Immunogold Labeling

Immunogold labeling was performed in accordance with prior established protocols [32]. Primary
skeletal myotubes were fixed for 2 h in 2% paraformaldehyde (PFA) and 0.125% glutaraldehyde
in 0.1 M phosphate buffer. Ultrathin cryosections were prepared, and single- or double-
immunogold labeling was performed using antibodies and protein A coupled to gold. Once

labeling was completed, they were imaged via TEM.

Lysotracker
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The protocol was performed based on prior procedures [33]. LysoTracker™ Red DND-99
(ThermoFisher Scientific, L7528) was diluted to a final concentration of 1 mM with dimethyl
sulfoxide (DMSO) to create a stock solution. The stock solution was then mixed with warm growth
media to a 1:2000 dilution. Growth media from the cells was aspirated and replaced with the
working solution of LysoTracker™ Red DND-99. Cells were imaged live using an SP-8 confocal
inverted microscope with a white laser light set to an excitation wavelength of 577 nm and an
emission wavelength of 590 nm £+ 10 nm. This allowed for a yellowish pseudo coloration to be
observed. For the staining of fixed cells, cells were grown in culture media on a #1.5 cover glass,
either embedded into a petri dish or divided by plastic-walled growth chambers to optimize
microscopic optics. Cells were incubated for 30 min with a working solution of LysoTracker™
Red DND-99. The staining solution was then aspirated from the plate, rinsed, and subsequently
fixed in 4% PFA. Confocal image stacks were captured with a Zeiss LSM-5, Pascal 5 Axiovert
200 microscope, using LSM 5 version 3.2 image capture and analysis software and a Plan-
APOCHROMAT 40x/1.4 Oil DIC objective. Images were deconvoluted with the National
Institutes of Health (NIH) ImageJ software and BITPLANE-Imaris software. Imaris software
analysis was used to measure lysosome number, volume, and area. Experiments were conducted

in triplicate, at minimum, and 10-20 cells per condition were quantified.

Immunofluorescence

Immunofluorescence was performed according to standard procedures [27,34]. For, live-cell
imaging, live cells were plated and imaged in MatTek 35 mm glass-bottom culture dishes and
grown on Matrigel. After the cells were grown, they were fixed with 4% (w/v) PFA in PBS for

30 min, followed by permeabilization with 0.25% Triton X-100 in PBS for 10 min at room
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temperature. Then, the cells were blocked with 10% bovine serum albumin in PBS. The fixed cells
were incubated with rabbit anti-lysosomal associated membrane protein (LAMP-1; Cell Signal:
D2D11) antibody in 1% BSA in PBST (PBS + 0.1% Tween 20) at a 1:25 dilution at 4 °C overnight.
After 3 PBS washes, each 5 minutes long, Alexa Fluor 488-conjugated goat-rabbit mouse IgG
(Life Technologies: A-11008) secondary antibodies were added at 1:1000 dilution in 1% BSA
and incubated at room temperature for 45 minutes in the dark. After another 3 PBS washes, the
coverslips were mounted onto glass slides with ProLong Diamond Antifade with 4’,6-diamidino-
2-phenylindole (DAPI) and allowed to dry overnight. Confocal image stacks were captured with
a Zeiss LSM-5, Pascal 5 Axiovert 200 microscope, using LSM 5 version 3.2 image capture and
analysis software and a Plan-APOCHROMAT 40x/1.4 Oil DIC objective. Imaris software analysis
was used to measure lysosome intensity, length, and sphericity. Experiments were performed in

triplicate, at minimum, and 10-20 cells per condition were quantified.

Human Myotubes

GIBCO® Human Skeletal Myoblasts were obtained (ThermoFisher Scientific, A1255). Cells
were thawed and plated in HG DMEM containing 1% penicillin/streptomycin, 1% fungizone,
and 2% horse serum. Cells were differentiated after 48 h, and myotubes were extracted.
Fibroblasts were grown in vitro to the third passage and plated in 6-well tissue culture plates (5
10° cells per well) in DMEM (Invitrogen) supplemented with 10% heat-inactivated fetal bovine
serum, 100 U/ml of penicillin, 100 pg/ml of streptomycin, 0.25 pg/ml of fungizone, 1 mm sodium
pyruvate, and 10 mm HEPES at 37 °C in a humidified incubator with 10% COx. Cells were infected

with Ad-Cre, while Ad-GFP was a control.
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Thapsigargin Treatment

Myotubes and fibroblasts were treated with thapsigargin in accordance with prior methods [8,35].
Fibroblasts, human myotubes, and mouse myotubes were treated with thapsigargin (2 pg mL™;
Sigma) for 10 h, followed by crosslinking with 1% formaldehyde, which was performed for 10

min.

Systematic ImageJ Parameters and Measurement

We utilized documented parameters and quantification methods [8]. A unique individual was
responsible for imaging the entire cell at low magnification. Obtained images were uploaded to
ImagelJ using an acceptable format, such as TIFF. The cell was then be divided into quadrants

using the ImagelJ plugin quadrant picking (https://imagej.nih.gov/ij/plugins/quadrant-

picking/index.html, accessed August 21, 2021). This ensured random and unbiased selection of

quadrants for quantification. Once the image was sectioned into four quadrants, two of these
quadrants were randomly selected for complete analysis. Three independent, blinded individuals
were tasked with performing the quantification of these quadrants according to the protocol
described below. Their collective findings were averaged to decrease individual subjective bias.
To ensure accurate and reproducible values, measurements were repeated for a minimum of 10
cells each. In future experiments, if significant variability is observed across the three individuals
performing the analysis, increasing the sample number (n) by expanding the number of cells
quantified was found to decrease variability.

All analysis methods were developed using NIH ImageJ software. Necessary measures should be
set on ImagelJ prior to analysis (Analyze > Set Measurements: Area, Mean gray value, Min & Max

gray value, Shape descriptors, integrated density, Perimeter, Fit ellipse, Feret’s Diameter).
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Measurements of lysosomes, autolysosomes, LDs, and autophagosomes, including area,
circularity, and length, were made using the Multi Measure region of interest (ROI) tool in Imagel
and were based on established measurements [8,36]. The freehand tool in NIH ImagelJ 1.49 was
used to manually trace the cellular degradation machinery membrane to determine the area or
volume. A 19 x 23 cm rectangular grid was overlaid on each image to quantify cellular degradation

structures in each image, and the numbers were presented per 10 pm? of the cytoplasm.

Statistical Analysis

The results are presented as the mean + standard error of the mean (SEM). Data were analyzed
using unpaired Student’s T-tests. If more than two groups were compared, one-way analysis of
variance (ANOVA) was performed, and significance was assessed using Fisher’s protected least
significance difference test. For T-tests and ANOVA, the GraphPad and Statplus software
package was used (SAS Institute, Cary, NC). For all statistical analyses, significant differences

were accepted when p < 0.05.

PROTOCOL:

1. Downloading and Preparing ImageJ Software for Analysis
1.1.  Download Image] software from the official NIH  website
(https://imagej.nih.gov/ij/download.html).
1.2.  Install and open the ImagelJ software.

1.3.  Select Analyze » Tools » ROI Manager to open the ROI Manager, which is

used to record and track measurements.
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1.4.  Click on Analyze » Set Measurements to input the measurements for ImageJ

to perform, such as area, circularity, and perimeter.

1.4.1. For the current protocol, area and count will be the focus; however, all
available measurements may be utilized, depending on the aims of the
study.

1.5.  Import the image to be analyzed (a TIFF or DM3 file is recommended due to their
high quality) directly into Imagel.

1.5.1. Alternatively, click File » Open to open the selected image.

1.6.  Considerations

1.6.1. For accuracy and reproducibility, ensure that each image contains a
scale bar, bar length, and image magnification. The scale bar and bar
length are important for setting the appropriate units within the ImageJ
settings.

1.6.2. Quantification of samples should be performed by three individuals in
a randomized and blinded manner to ensure an unbiased approach.

1.6.3. To save time, images may be divided into quadrants, and the same
quadrants should be analyzed across all images.

2. Analyzing Lysosomes, Autophagosomes, and Autolysosomes (Supplementary Figure
24-C)
2.1.  Click on Freehand Selections to access the Freehand tool.
2.2.  Trace the outline of the entire cell.
2.3.  Click Add on the ROI Manager. This ROI will be used to normalize later

measurements.
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2.4.  To obtain the length and width, use the Straight-Line tool to draw a line down the
major and minor axes of each organelle (Supplementary Figure 2A—C, Step 1).
2.5.  Trace the membrane of each lysosome, autophagosome, or autolysosome. Add the
shape to the ROI Manager (Supplementary Figure 2A—C, Step 2).
2.6.  Click Measure in the ROI Manager to obtain measurements for the area.
2.7.  Add the measurements to the ROI Manager and use the Measure function to obtain
numerical values for each measurement.
2.8.  Considerations
2.8.1. Ensure that autophagosomes, lysosomes, and autolysosomes are being
measured separately because the ROI Manager will group all functions
together for statistical analysis.
2.8.2. The number of autophagosomes, lysosomes, or autolysosomes counted in
the cell should be normalized against the total cell area.
3. Analyzing Lipid Droplets
3.1.  Repeat Steps 2.1-2.5 for LDs to obtain the basic measurements needed for analysis
(Supplementary Figure 2D).
3.2.  For each cell, calculate the total area of all LDs. The amount of lipid coverage is
the total area of all LDs divided by the total cell area.
3.2.1. This process can be used to determine the percent coverage of other
subcellular structures, including mitochondria and recycling machinery.
3.3.  Contact sites between organelles can be measured by first using the Freehand tool
to trace the outer membranes of both subcellular structures being analyzed, as

described in Step 2.4 (Supplementary Figure 2D, Step 1).
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34. To determine the contact site length, click on the Straight, Segmented, or
Freehand Lines tool on the toolbar, and select Freehand Line. Draw a line
spanning the length of the contact site, add the measurement to the ROI Manager,
and use the Measure function to determine the length of the contact
(Supplementary Figure 2D, Step 2).

3.5.  The contact distance may be similarly measured by using the Freehand Line tool
to draw a line between the two objects being measured.

3.6.  To calculate percent coverage, simply divide the cumulative contact lengths by the
percent coverage of one of the two subcellular features in question, as determined

in Step 3.2, and multiply the value by 100 to obtain a percentage.

REPRESENTATIVE RESULTS:
This protocol describes a method for obtaining reproducible measurements and the
identification of structures involved in the autophagic process. Below, we discuss the results

obtained using this TEM image analysis approach.

Identification of organelle compartments by immunogold labeling

Considering some of the pitfalls associated with correctly identifying organelles by TEM
morphology alone, other methods may be required to monitor organelles. One of the most effective
alternatives is the immunogold labeling technique used in electron microscopy to analyze
organelle marker proteins. In mitochondria, the mitochondrial GTPase proteins mitofusin 1 and 2

(MFN1 and MFN2) function in mitochondrial fusion reactions [21,22,37—40]. Thus, mitochondria
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can be readily identified by MFNI in tissues due to the formation of MFN1-positive puncta (Figure
10-P).

The fundamental concept of immunogold labeling can be applied to organelles associated
with autophagy. Many novel yeast genes that are essential for autophagy (autophagy-related, or
ATG genes) have been characterized, and most of their mammalian homologs have been identified
[41]. Microtubule-associated protein 1 light chain 3 (LC3) is the mammalian homolog of Atg8
[42] and is a reliable marker for autophagosomes in mammals. Thus, autophagosomes can be
positively identified by the formation of LC3-positive puncta (Figure 1Q-R). The expression
levels of LC3 in different autophagosomes (Figure 1, blue arrows) and phagosomes (not shown)
may be variable due to the degradation of LC3 by lysosomal hydrolases, which can make the
identification of late-stage autophagic materials more challenging [43]. However, the
identification of LC3-positive puncta remains beneficial for the identification of autophagosomes.
Immunogold labeling has also been performed with caveolin-1 (CAV-1), which is a marker protein
for specialized membrane domains known as caveolae, which ultimately accumulate in
caveosomes that mature into MVBs upon endocytosis [44]. Therefore, CAV-1 immunogold
labeling can be used to identify MVBs (Figure 1S-T), and the presence of CAV-1 puncta in an
ROI can be used to exclude those vesicles from classification as autophagosomes, indicating
instead the presence of a multivesicular or multi-inclusion body. After we tested immunogold
labeling, we examined changes in the cellular degradation machinery under other conditions.
Thapsigargin treatment alters lysosome, autolysosome, and autophagosome morphology

We also investigated the morphological changes that occurred in lysosomes,
autolysosomes, and autophagosomes in response to thapsigargin treatment (Figure 2).

Thapsigargin is a sarcoplasmic-ER Ca*"-ATPase (SERCA) inhibitor, and thapsigargin treatment
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in cells causes a decrease in the lengths of mitochondria—ER contacts while also inducing ER
stress [8,45]. Using our TEM image analysis protocol, we found that both the mean lysosomal
area and the number of lysosomes per square micron significantly increased in response to
thapsigargin treatment in primary mouse skeletal myotubes (Figure 2E—F). The mean area of
autolysosomes and the number of autolysosomes per square micron showed an even greater
increase than the values for lysosomes (Figure 2G—H). The mean autophagosomal area and the
number of autophagosomes per square micron also significantly increased in thapsigargin-treated
cells (Figure 2I-J). Similar results were demonstrated in both mouse fibroblasts (Figure 2K-T)
and human myotubes (Figure 2U-AD). Human myotubes displayed the largest increases in
autophagy recycling machinery for all assessed components. Accompanying these
quantifications are representative images for each cell type (Figure 2A-D, K-N, and U-X).
Thapsigargin inhibits ER function and promotes cellular stress, and these findings support a
model in which cell-stress-induced organellar damage increases the activity of machinery,
including lysosomes and autophagosomes, to degrade damaged organelles. Thus, the
morphological changes detected and quantified using the TEM method are consistent with the
expected effects of thapsigargin treatment.
DRP-1 ablation results in increased degradation machinery

Dynamin-related protein (DRP-1) is a crucial protein involved in the regulation of
mitochondrial fission [29,46]. Other studies have reported that the impaired mitochondrial fission
can have downstream effects on organellar morphology and function throughout the cell [47]. In
the absence of DRP-1, mitochondria undergo fission less frequently, resulting in longer
mitochondria that can trigger potential downstream effects, including apoptosis [46]. To test our

method, we generated a skeletal muscle-specific DRP-1 knockout mouse and observed changes in
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the degradation machinery. Specifically, our study focused on lysosomes, autophagosomes, and
LDs, which are all closely linked to the process of autophagy. For lysosomes, we investigated the
effects of DRP-1 ablation in a skeletal myotube-specific knockout model (DRP-1smKO), which
resulted in a significant and large increase in lysosome numbers compared with the wild-type
control (Figure 3A—F, red arrows). Additionally, we observed increases in both the number of
lysosomes per square micron and the lysosomal area per square micron, although the change in
lysosomal area was not as great as the absolute change in lysosome number (Figure 3G-H).
Similarly, DRP-1smKO also resulted in a significant and large increase in the autophagosome
number compared with the wild-type control (Figure 3I-L, red arrows). Additionally, we observed
increases in both the number of autophagosomes per square micron and the autophagosomal area
per square micron, although the change in area was less than the absolute change in number (Figure
3M-N). For both results, based on the change in percentage and the degree of significance, the
increase in autophagosomes was greater than the increase in lysosomes, which suggested that
reduced mitochondrial fission may cause larger shifts in the formation of cargo vessels than in the
formation of lysosomes, although both types of organelles increased significantly.
Autophagosome—lysosome fusion events may also contribute to this disparity, as during the
intermediate fusion phase, these structures more closely resemble autophagosomes than
lysosomes.

To further validate these results, we also used fluorescent dyes to image lysosomes in DRP-
I1smKO myotubes. LysoTracker is a fluorescent dye used to label and track acidic organelles in
live cells, which can be used to effectively identify the highly acidic lysosomes. Similar to the
TEM data, the LysoTracker assay showed that DRP-1smKO resulted in a significant increase in

lysosomes compared with the wild-type control (Figure 30-P). Increases in lysosomal number,
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lysosomal calculated volume, and lysosomal area were also observed in DRP-1 knockout mice
(Figure 3Q-S). These key quantifications are similar to the quantifications determined by TEM
analysis; however, LysoTracker analysis provides better certainty that lysosomes are being
measured. Lysosomes can also be identified by LAMP1 immunostaining (Figure 3T-U) [48].
When using LysoTracker, traditional statistical analyses can be performed to determine the area
and numbers of lysosomes. When applying LAMP1 staining, the area cannot be as reliably
obtained, but the relative intensity can provide an estimation of LAMP1 expression in lysosomes,
which correlates with the number and size of active lysosomes (Figure 3V). Additionally, other
metrics, including length and sphericity, can be determined when using these fluorescent dyes,
which suggested that lysosomal dysfunction occurred as length increased and sphericity decreased
(Figure 2W-X).
DRP-1 ablation results in increased lipid droplets

We also measured LDs in skeletal muscle from DRP-1smKO mice, which demonstrated a
significant increase in LDs compared with the wild-type control (Figure 4A—B, red arrows). We
observed a large increase in the lipid area per square micron and the number of lipids per square
micron (Figure 4C-D). The increase in LDs was larger, based on the change in percentage, than
the observed increases in both lysosomal and autophagosomal structures following DRP-1 ablation
(Figures 3 and 4). Increased LDs have previously been described as a downstream effect of
autophagy, which supports the conclusion that autophagy increased in frequency following DRP-
1 ablation [18]. We propose that this increase in autophagic activity may be due to dysfunctional
regulation of mitochondria length, which has previously been demonstrated in response to the loss
of DRP-1 regulated fission [18,46]. These results suggest that DRP-1 ablation and the resulting

lack of mitochondrial fission increase autophagy in cells, demonstrated by the upregulation of the
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cellular degradation machinery. Past studies have found that mice lacking DRP-1 are associated
with the increased accumulation of damaged mitochondria [47], which may induce increased
mitophagy and thereby induce the relevant recycling machinery.
Knockdown of Marf resulted in more abundant lysosomes

In addition to DRP-1, we sought the quantify changes in lysosomes in response to the
knockdown of other key mitochondrial proteins. Mfn2 is an important regulator of mitochondrial
fusion [49,50]. Previous studies have shown that Mfn2 deficiency is associated with disrupted ER
morphology and mitochondria—ER contacts, resulting in dysfunctional calcium signaling pathways
[49,50]. Furthermore, loss of Mfn2 has recently been shown to influence autophagic pathways
[49-52]. Specifically, loss of Mfn2 has been shown to stall autophagy at the lysosome and
autophagosome stage, causing a buildup in both autophagosomes and lysosomes, by inhibiting
their fusion [52]. The Drosophila homolog of Mfn2 is Marf, and previous research examining the
knockout of genes upstream of Marf demonstrated downstream effects on autophagy [51]. Given
this emerging link between autophagy and Marf/Mfn2, we examined the effects of Marf
knockdown in Drosophila tissue. Marf knockdown resulted in a significant and large increase in
lysosome number compared with the wild-type control (Figure SA-B, D). Additionally, we
observed an increase in the average lysosomal area (Figure 5C). These findings indicate a potential
upregulation in autophagy, which may represent an autophagic response to ER and mitochondrial
stress caused by the loss of Marf [49-52]. Further research highlighting changes in other cellular
degradation machinery following the loss of Mfn2/Marf could better elucidate the effects of

Mitn2/Marf on the autophagic pathway.

DISCUSSION:
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The method described here involves measuring organelles in each image or image quadrant
by defining the area of interest using digital tools, which differ from the often-used method of
point counting. Point counting can be used to determine the cellular area by overlaying a grid over
the cellular area and quantifying the distance between the gridlines and the number of grid
intersections, or points, within the cell. The cellular area may then be estimated using the equation
P x d?, where p represents the number of points and d represents the grid distance [26]. Smaller
grids can be used to repeat the process for the estimation of organellar area, and these two values
can then be utilized to determine the percentage coverage of organelles. Past studies have used
point counting to successfully streamline the process of calculating organelle coverage; however,
the outcomes of point counting are estimations [26]. Even when the grid distances are smaller,
which can increase the accuracy of the calculation, this measurement includes some level of
estimation. The method we described uses ImagelJ to calculate a more exact area for the structures.
Although this process is more time-consuming, the results are highly reproducible, and high-
quality data is generated that may be further analyzed using ImagelJ. Both forms of analysis remain
driven by human evaluation and require the proper identification of the recycling machinery in
question. Both point counting and ImageJ-based measurement techniques are viable methods for
measuring the frequency of recycling or other types of organelles; however, we view the more
accurate measurements associated with ImagelJ analysis to be worth the potential increase in time
commitment [23,24].

Another consideration is the magnification and the scope of cellular degradation machinery
components that are considered in these analyses. Significant heterogeneity in sizes can be
observed among components of the degradation machinery, even within the same classification

group, which can vary in proportion to the amount of cargo they may hold (Figure 1). The various
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organelle types may require different magnification levels to obtain the necessary dimensions
when performing TEM imaging (Supplemental Figure 1). Additionally, when deciding which
types of recycling machinery should be evaluated, the purpose of the analysis should be
considered, and relevant statistical analyses should be applied to obtain appropriate results
(Supplemental Figure 1). For example, the total number of LDs may not be as impactful as their
total cell coverage due to the varying sizes of LDs. Therefore, proper magnification should be
determined in relation to the necessary measurements that must be performed (Supplemental
Figure 1). One limitation of our method is that for key measurements, such as area, the total
organelle should be visualized to obtain the most reliable results. Point counting can be used to
evaluate images in which the entire organelle is not visible because it relies on estimation [26].
However, when using ImagelJ, the entire organelle is outlined, and magnification that is too high
may limit the amount of data that can be collected. However, images of a single cell at varying
magnifications may be used by normalizing against the same scale across all images.

Although this protocol focuses primarily on the evaluation of the degradation machinery,
these organelles must not be viewed in a vacuum. Autophagy can target any cell, and various
factors can alter the autophagy rate in various cells, as exemplified by changes in cancer,
metabolic diseases or neurodegenerative diseases [1,4,9]. Many organelles are closely associated
with the overall process of autophagy. Recent research has found that omegasomes and
autophagosomes primarily form at mitochondria—ER contact sites [25], which may be associated
with the necessity of phosphatidylinositol 3-phosphate, an ER phospholipid, for the activation
and formation of autophagosomes [1-3]. Tangentially, research has also found that
mitochondrial-derived vesicles can factor into autophagic pathways by transporting proteins and

lipids associated with the mitochondria to MVBs [53]. This previously unknown pathway
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indicates that mitochondria that are not sufficiently damaged to undergo mitophagy can still
produce endocytic bundles that are transported to the MVB for recycling via the autophagic
pathway. Cellular degradation machinery can have important effects on organelles, and the
inverse is also true. To properly study autophagy, a holistic view should be applied with respect
to cellular organelles to better understand the nuances that influence autophagy.

The protocol described here is optimal for the performance of various statistical analyses;
however, a primary concern is ensuring that the correct subcellular features of lysosomes,
autophagosomes, and LDs are identified and measured. Although organelles can be accurately
identified using TEM analysis alone, the use of additional methods, such as immunofluorescent
staining, is recommended in tandem with TEM analysis. Clear and useful results can be obtained
from complementary methods, particularly when analyzing lysosomes, autophagosomes, and
autolysosomes, which can easily be misidentified (Figures 1 and 3). Examining organellar
morphology using TEM alone may not be sufficient and could lead to inaccurate conclusions.
Thus, to verify and validate the correct identification of each organellar structure, we propose that
other methods should be performed in tandem with TEM, such as immuno-TEM with gold
labeling, LysoTracker with an overlay of correlative light and electron microscopy, and
immunohistochemistry or immunofluorescence (Figure 1 and 3) [5,41,54].

Given the acidity and multitude of proteins associated with lysosomes, various avenues are
available for the identification of lysosomes through immunogold labeling, LysoTracker to
identify acidic organelles, and the use of immunofluorescent dyes to label lysosome-associated
proteins or indirect immunofluorescence through the use of secondary antibodies bound to primary
antibody associated with lysosomes [55]. For example, past studies have utilized the staining of

LAMPI to detect lysosomes (Figure 3T—U) [48]. When combining confocal fluorescence imaging


https://doi.org/10.1101/2021.09.26.461841
http://creativecommons.org/licenses/by-nc-nd/4.0/

bioRxiv preprint doi: https://doi.org/10.1101/2021.09.26.461841; this version posted September 27, 2021. The copyright holder for this preprint
(which was not certified by peer review) is the author/funder, who has granted bioRxiv a license to display the preprint in perpetuity. It is made
available under aCC-BY-NC-ND 4.0 International license.

and TEM, fluorescence can be used to identify the presence of specific proteins and confirm the
identities of autophagic organelles (Figure 30—X), and TEM can then be used to measure the finer
details, including area, average number, and percent coverage (Figure 3A—N). Increased noise and
decreased ultrastructural details may be observed when buffer is utilized with these techniques;
therefore, sample additives should be minimized, and immunofluorescent dyes should only be used
when necessary [56].

Current options are limited for the identification and classification of autophagosomes.
Immunogold labeling can be utilized against LC3-II, which is currently the standard and only
known autophagosomal marker [41,54,57]. LC3 puncta may not always be detectable in
autophagosomes; however, the application of immunogold labeling can be effectively applied for
the identification of organelles that should be excluded from the analysis of autophagosomes. For
example, CAV-1 staining (Figure 1S-T), which is associated with caveolae typically found in
MVBs, can be used to identify MVBs that might be mistaken for autophagosomes (Figure 1H)
[44]. Similarly, perilipin 2, which is a commonly expressed protein associated principally with
LDs, can be used for the identification of LDs [58]. Future studies that continue to explore new
avenues for better immunogold or immunofluorescence labeling options for autophagosomes are
also important. Due to the potential ambiguity associated with identifying the cellular degradation
machinery, we recommend the use of at least one additional complementary technique for the
verification of lysosome and autophagosome identification when measuring TEM images.

Although limitations exist for this TEM analysis method, when combined with other
techniques, the reliable identification and quantification of cellular degradation machinery
components may be possible. On a broader scale, this basic method utilizing ImageJ may be

applied to many fields of study with a focus on organelle structure. For example, mitochondria
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have been shown to play key roles in many complex diseases, including type II diabetes,
cardiomyopathy, and Alzheimer’s disease [21,22,37—40]. Additionally, autophagy may play a role
in these diseases, given its role in mediating mitophagy to clear dysfunctional mitochondria. The
use of TEM and ImagelJ to study other organelles in conjunction with the precise methodology
outlined here for the study of key autophagic organelles will lead to a better understanding of the

physiology associated with other key organelles and their contributions to disease.

PERSPECTIVES ON STAINING:

Various lysosome stages may look different when using different EM staining
procedures. Lysosomes will present differently depending on the material used for preparation
(e.g., osmium or osmium tetroxide) and the type and amount of additives used (e.g., uranyl
acetate, lead citrate, and ruthenium red). Depending on the stain used, contrasts of the lysosomal
membranes may be altered, changing how lysosome-related structures appear. All EM images
shown here used a grid-based staining technique that is used across all procedures (Table 2). The
general TEM sample preparation protocol used glutaraldehyde and 1% osmium tetroxide as
fixatives [59—-62]. From there, post staining on TEM ultrathin sections utilized 5% Uranyl
Acetate (UA) for 6 min and Reynold’s Lead Citrate for 3 min [63—65]. These are commonly
used reagents for staining; UA can increase membrane contrast and lead citrate can improve
resolution of cellular structures. Different stains can be used to better suit the purpose of the
experiment being performed, and application length of stains should be adjusted accordingly to
the sample type. Other viable alternatives exist; for example, ruthenium tetroxide may be used,
especially for the preparation of kidney, liver, and prostate tissue [66,67]. Ammoniated

ruthenium oxychloride, commonly referred to as ruthenium red, is also frequently used as a
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polycationic dye to stain negatively charged molecular species, including polysaccharides, in
tissue sections [68—70]. Although ruthenium red is commonly used for fungal staining, when
used in tandem with osmium tetroxide, a chemical reaction happens that may increase contrast of
TEM micrographs [68—70]. Regardless of the stain used, the foremost concern should be
remaining consistent in staining tissues. Different staining in the same organism, for example
staining separately for lysosomes, should be avoided. Ideally, the same staining solution should
be used for all samples, even different stages, this way it is possible to compare between
different time or stages. However, if staining protocols used are different than the ones laid out
here due to adjustments being made, appearances of lysosomes may vary.
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Figure 1. Identification of lysosomes, autolysosomes, lipid droplets, multilamellar vesicular
bodies, autophagosomes, inclusion bodies, mitochondria, and lipid droplets using TEM and
immunogold labeling. (A-N) Red arrows show lysosomes, yellow arrows show multivesicular
inclusion bodies, green arrows show varying autophagosomes, orange arrows show lipid droplets,
purple arrows show multilamellar vesicular bodies, and blue arrows show autolysosomes. (O-T)
Immunogold labeling using mitofusin 1 (MFN-1), microtubule-associated protein 1 light chain 3
(LC3), and caveolin 1 (CAV-1) to identify mitochondria. (O and P) Several representative images
of mitochondria featuring MFN-1 immunogold labeling. In mitochondria, MFN-1 can be identified
by black dots as MFN-1 puncta. (O.1-3, blue arrows) MFN-1 is not always consistently expressed
throughout the mitochondria but will be evident in most mitochondria, especially at lower
magnifications. (P.4-6, blue arrows) In mitochondria undergoing fusion, or having recently
undergone fusion, an increased number of MFN-1-positive puncta will be visible. (Q and R)
Several representative images of autophagosomes identified using LC3 immunogold labeling. In
autophagosomes, LC3 presence can be identified by black dots as LC3 puncta. Unlike many other
forms of immunogold labeling, LC3 puncta do not have a consistent appearance. As a result, as
identified by the blue arrows, they may appear as (Q.1, left arrow) clusters of thick puncta, (Q.2,
middle arrow) internal puncta, (Q.3, right arrow) proximal to the membrane, (R.4, left arrow)
faded and clustered, (R.S, middle arrow) alone and faded, or (R.6, right arrow) in varying sizes.
This diversity of puncta can still pose challenges to the identification of autophagosomes using
immunogold labeling. CAV-1 can be used to identify vesicles, including multivesicular bodies,
which are easily mistaken for autophagosomes. (S and T) CAV-1 positive puncta can be difficult
to identify in lower-magnification images and may blend in with the background. (S.1-3, blue
arrows) Many vesicles will have multiple puncta rather than a singular punctum. (T.4—6, blue
arrows) CAV-1-positive puncta cluster around the membrane and inside of multivesicular bodies.
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The presence of CAV-1 puncta indicates that these organelles are not autophagosomes or
lysosomes.
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Figure 2. Thapsigargin alters lysosomal, autolysosomal, and autophagosomal
morphologies in primary mouse skeletal myotubes, mouse fibroblasts and human
myotubes. (A-D) Representative transmission electron microscopy (TEM) images of cellular
degradation machinery in skeletal muscle from untreated (red outline) and thapsigargin-treated
(blue outline) mouse myotubes. Lysosomes are identified by red arrows, green arrows show
autophagosomes, and blue arrows show autolysosomes. (E) Quantification of the lysosomal
area in each treatment group. (F) Quantification of the number of lysosomes per square micron.
(G) Quantification of the autolysosomal area. (H) Quantification of the number of
autolysosomes per square micron. (I) Quantification of the autophagosomal area in each
treatment group. (J) Quantification of the number of autophagosomes per square micron. (K-
N) Representative TEM images of cellular degradation machinery in mouse fibroblasts from
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untreated (red outline) and thapsigargin-treated (blue outline) cells. (O) Quantification of the
lysosomal area in each treatment group. (P) Quantification of the number of lysosomes per
square micron. (Q) Quantification of the autolysosomal area. (R) Quantification of the number
of autolysosomes per square micron. (S) Quantification of the autophagosomal area in each
treatment group. (T) Quantification of the number of autophagosomes per square micron. (U—
X) Representative TEM images of cellular degradation machinery in human myotubes from
untreated (red outline) and thapsigargin-treated (blue outline) cells. (Y) Quantification of the
lysosomal area in each treatment group. (Z) Quantification of the number of lysosomes per
square micron. (AA) Quantification of the autolysosomal area. (AB) Quantification of the
number of autolysosomes per square micron. (AC) Quantification of the autophagosomal area
in each treatment group. (AD) Quantification of the number of autophagosomes per square
micron. Significant differences are indicated by asterisks; *, ** *** **** indicate p < 0.05, p
<0.01, p <0.001, and p < 0.0001, respectively.
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Figure 3. Knockout of dynamin-related protein (DRP-1) increases lysosomes and
autophagosomes, as identified through TEM, lysotracker, and lysosome-associated
membrane protein (LAMP1). (A-F) Representative transmission electron microscopy (TEM)
images of skeletal muscle myotubes from DRP-1 knockout (bottom) and wild-type (top) mice.
Lysosomes are indicated by the red arrows while green arrows show autophagosomes. (G)
Quantification of the normalized number of lysosomes per cell micrometer and (H) average
lysosomal area. (I-L) Representative TEM images of skeletal muscle cells from DRP-1 knockout
(bottom) and wild-type (top) mice. Autophagosomes are indicated by the red arrows. (M)
Quantification of the normalized number of autophagosomes per cell micrometer and (N) average
autophagosomal area. (O and P) Representative images of DRP-1 smKO and wild-type (WT)
lysosomes with lysotracker applied. (Q) The number of lysosomes, (R) the average calculated
volume, and (S) the average area of the lysosomes, all of which increased upon DRP-1 ablation.
(T and U) Lysosomes can be identified using the immunofluorescent labeling of LAMP1 protein.
(V) The intensity of the signature LAMP1 blue color can be measured to determine the frequency
of active lysosomes in the cell. (W) Lysosome dysfunction or changes in morphology can be
determined by measuring the length of fluorescence signatures, and (X) the sphericity of regions
of interest. Significant differences are indicated by asterisks; *, **, #*** #¥** jpdicate p < 0.05, p
<0.01, p<0.001, and p < 0.0001, respectively.
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Figure 4. Knockout of dynamin-related protein (DRP-1) increases lipid droplets in mouse
skeletal myotubes.

(A and B) Representative transmission electron microscopy (TEM) images of skeletal myotubes
from DRP-1 knockout (bottom) and wild-type (top) mice. Lipid droplets are indicated by the
orange arrows. (C) Quantification of the total lipid area and (D) the normalized number of lipid
droplets per um? of cell area. Significant differences are indicated by asterisks above the
respective figures; **, **** indicate p < 0.01 and p <0.0001, respectively.
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Figure 5. Knockdown of MAREF increases lysosome number and average lysosome area.

(A and B) Representative transmission electron microscopy (TEM) images of cellular degradation
machinery from control (red outline) and mitochondrial assembly regulatory factor (MARF)
knockdown (KD; blue outline) in drosophila tissue. Lysosome examples are identified with red
arrows. (C) Quantification of the normalized number of lysosomes per um? of cell area and (D)
average lysosomal area. Significant differences are indicated by asterisks above the respective
figures; ** and **** indicate p < 0.01 and p <0.0001, respectively.
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Supplemental Figure 1. Proper measurement and magnification for analyzing essential
recycling machinery. To accurately assess lysosomes or autophagosomes, the lysosome and
autophagosome numbers, area, and diameters should be measured. This strategy is the same
strategy applied to mitochondria. (A—I) Magnifications should be standardized to acquire a clear
understanding of the morphological changes observed in mitochondria and other organelles.
Recycling machinery varies considerably in size depending on the organelle. Thus, no single
magnification can encompass all structures of interest. For example, omegasomes can be large and
require each structure to be individually quantified relative to the endoplasmic reticulum (ER). (A
and B) The structure and quantity of these organelles vary between cell types and across treatment
conditions. (C—H) Alternatively, the recycling machinery, such as lysosomes, autophagosomes,
and autolysosomes, can be analyzed at 1000% to measure the area, diameter (length and width),
and quantity. (I) 1000x magnification can be used to count ER-isolation membranes (ER-IMs). To
view detailed morphology, the use of magnifications lower than 4000% is recommended.
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Supplemental Figure 2. Workflow and representative images of the quantification of
autophagosomes, lysosomes, autolysosomes, and lipid droplets. (A) The fundamental process
used to evaluate lysosomes using key measurements, including length, width, area, number, and
density. Lysosomes are all indicated in representative images by circles quantifying area and lines
spanning the Feret’s diameters. (B) Additional representative images show the same information
for autophagosomes and (C) autolysosomes. (D) Slightly differing quantifications should be
performed for lipid droplets, although they may all be easily performed using ImagelJ. All of these
quantifications should be performed separately, on an organelle type-by-organelle type basis, to
avoid the accidental confusion of regions of interest.
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It is important to properly identify and distinguish degradation machinery depicted in Figures
1-5. Although under TEM without any other methods being used in tandem, degradation
machinery may look similar, several key differences can be used to distinguish these structures.

- Lysosomes and autolysosomes can be misidentified because both share similar circular
or elongated, ovular shapes. Additionally, when imaged via transmission electron
microscopy (TEM), the membrane will appear as a black circle surrounding both
lysosomes and autolysosomes. Lysosomes feature multiple membranes, which can result
in an appearance similar to that of a multilamellar vesicle; however, typically, lysosomes
feature fewer membranes and contain more evident enzymes than multilamellar vesicles.
Traditional lysosomes feature defined membranes containing permeases and a lighter
interior filled with enzymes. Although lysosomes appear slightly darker, they still have
a mostly consistent color, whereas autolysosomes feature a clear center area, which is an
indicator of having undergone fusion.

- Autophagosomes may be mistaken for both lipid droplets and inclusion bodies, although
some key differences may be observed. At a higher magnification, multivesicular bodies
may also appear to feature multiple membranes; however, many multivesicular bodies
contain lipids, which gives the interior compartment of multivesicular bodies an
inhomogeneous appearance compared with autophagosomes. Similar to
autophagosomes, multivesicular bodies can have a similar cargo-laden appearance,
especially from at lower magnification. In such cases, a higher magnification can be used
to identify differences between multivesicular bodies and autophagosomes.

- Autophagosomes may also be mistaken for lysosomes or other organelles.
Autophagosomes without cargo can resemble lysosomes, especially if they clump. The
varying stages and cargoes of autophagosomes give them varied appearances, including
some with incomplete membranes, whereas others have more complete membranes and
contain cargo. At high magnification, autophagosomes appear to have two or more
membranes, and the cargo typically appears as defined sacs that are more circular rather
than as cristae or other artifacts.

- Autolysosomes or autophagosomes can also be easily mistaken for lipid droplets due to
the similar color and appearance of these two structures. Lipid droplets are typically
located in a single area near the edge of the cell, which is not typical behavior for
autophagosomes, which are found closer to the center of cells and rarely clump.
Additionally, unlike autophagosomes, lipids have a small membrane that is barely visible
in many cases. Furthermore, lipid droplets may be differentiated by a greater degree of
clumping, a single, thinner membrane, and a greater diversity in sizes. Lipid droplets
may appear similar to autolysosomes. Autolysosomes in an earlier stage of fusion are
marked by two clear sacs.

- Multilamellar vesicles can present akin to autolysosomes. Multilamellar vesicles have
many lipid bilayers, which give them a ring-like appearance. However, these rings, when
examined under high magnification, have a disorganized and crooked pattern that allows
for their identification. In contrast, many ovular autolysosomes feature clear, circular,
white autophagosomal compartments, which are indicative of cargo contained within the
autolysosomes.

Supplemental Table 1. Identification of Degradation Machinery
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Grid stainihg for TEM

Materials
5% Uranyl Acetate (UA)
Reynold's Lead Citrate
NaOH pellets
1 N NaOH
2 clean, disposable Petri dishes
dd Hz0 in squirt bottle
3 beakers filled to % full with dd H:O
Filter paper cut into small triangles
Self-closing fine tipped forceps
2 micro-centrifuge tubes
Prepare stains
Draw up ~ 0.5 ml of clear UA into a glass pipette, avoiding precipitates (DO NOT STIR).
Place in a microcentrifuge tube.
Repeat with lead citrate.
Centrifuge stains for 5 minutes at 1:3,000 rpm.
Stain Grids with uranyl acetate
Using only the topmost supematant, place drops of UA (one per grid to be stained) onto a
clean Petri dish. Be sure and label positions.
Float Grids, section side down on the surface of the droplets.
Allow to stain for 2 minutes.
Float grids on to a clean drop of dd H:z0.
Rinse Grids thoroughly
One by one, pick up grids with forceps and rinse by dripping dd H:zO from the squirt bottle
onto the forceps above the grid. The water should then run gently over the grid.
Holding the grid vertically over the first beaker of dd H:=O, dip the grid in
and out of the water 30 times.
Repeat for the other two beakers.
Finally rinse again with squirt bottle.
Hasten drying by blotting visible liquid with filter paper triangles between
the tines of the forceps. Dry thoroughly.
Stain with lead citrate
Place several pellets of NaOH into the side of the remaining Petri dish.
Wet pellets with 1N NaOH.
Using only the topmost supernatant, place drops of lead citrate (one per grid to be
stained) onto prepared Petri dish. Label positions.
Float Grids, section side down on the surface of the droplets.
Allow to stain for 2 minutes.
Float grids on to a clean drop of dd H:0.
Rinse Grids thoroughly
One by one, pick up grids with forceps and rinse by dripping dd H:O from the squirt bottle
onto the forceps above the grid. The water should then run gently over the grid.
Holding the grid vertically over the first beaker of dd H:=O, dip the grid in and out of the
water 30 times.
Repeat for the other two beakers.
Finally rinse again with squirt bottle.
Hasten drying by blotting visible liquid with filter paper triangles between
the tines of the forceps. Dry thoroughly.
Store in grid box.
Clean up your area.

Supplemental Table 2. Grid Staining for TEM. Protocol for using uranyl acetate and lead citrate
for grid staining.
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